OpenWorkse Software
Version 5000.8.3.0

Release Notes — Revised

Contents

What’s In This Release ............oooo i 2
Welcome to the OpenWorks® Software ... 3
System ReqUIrEMENTS ... e 5
Installation INSIrUCtIONS ... 5
Third Party Applications ... e e e e e e e eeeees 6
International Trade COMPlIANCe .............oooiiiiiiiiiiiiiiirr e 7
Enhancements and New Functionality ... s 9
FIXEA ISSUES ... e e e e e e e e 12
KNOWN ISSUES ...t e e e e e e e e e e e e e e e e e e e e e s annnes 19
Compatibility with Discovery™ On OpenWorks® Software ..............cccccccvvvvveeeeeen. 26
Contacting Landmark Customer SUPPOIt ...........ccooiiiiiiiiiiiiieeeeeer e 29
Copyright and Trademark Information ..................ocooi e 31

HALLIBURTON Landmark Software

&8 Services

5000.8.3.0 Release Notes — Revised Page 1 of 32 March 2013



OpenWorks® Software

What’s In This Release

The 5000.8.3.0 release of the OpenWorks® software provides new features and defect fixes. The
highlights of this release are:

OpenWorks® Software
*  OpenWorks® Launcher in Windows for OpenWorks® and Landmark applications.

¢ No data model extensions.

GeoDatalLoad™ Software

e Data Import and Data Export Tools

* Data Import and Data Export Wizards are refashioned to make them easier to use, and
renamed Data Import and Data Export. The wizard actions have been removed.

* Added to the Basic installation of the OpenWorks® and GeoDatalLoad™ software.
* Improved tab interface, format editor, and other interface improvements.
* New import data types: horizon data, log curves, and well data.

» Data Import supports loader formats from ASCII Loader and GeoGraphix® Wellbase
ASCII 3.

* For [HS 297 and IHS 298, Data Import supports both fixed-length and comma delimited
fields in the data file, where ASCII Loader only supports fixed-length. The formats for IHS
data have been consolidated into four types: 297all, 297comma, 298all, and 298comma.
This allows a more simplified workflow for loading IHS 297 and IHS 298 data.

* SEG Y Loader is refashioned, has a new format editor, and supports more data types.

e Stimulation Data Loader supports multiple monitor wells.

To go directly to more information on the new features and changes, other enhancements, fixed
issues, and known issues for the OpenWorks® software, click on the links below:

Enhancements and New Functionality
Fixed Issues

Known Issues
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Welcome to the OpenWorkse Software

The OpenWorks® software version 5000.8.3.0 is a full release of the OpenWorks® software and
its Import/Export utilities (the GeoDatalLoad™ software). Newer utilities are documented in the
online help, and older utilities are documented in the manuals (in PDF format). The online help has
links to the manuals.

NOTICE: Changes to Oracle Licensing — Oracle Embedded Software
License (ESL)

Due to new licensing requirements for the software of the Oracle database, the OpenWorks®
software is moving to an embedded-use Oracle license (Embedded Software License, or ESL).
Version 5000.8.1.0 of the OpenWorks® software is the first release to provide this functionality.

The Oracle ESL applies to any customer who licenses OpenWorks with Oracle (the OpenWorks
software with the Oracle database software embedded), has an Oracle 11g installation, and does
not have a separate contract with Oracle. Landmark will not provide an ESL solution with
Oracle 10g.

As part of Oracle ESL compliance, customers who fit the above profile are no longer licensed to
use Oracle tools directly, including SQL*Plus. The OpenWorks software provides the following
tools to enable Oracle ESL compliance:

* The Oracle 11g database software is embedded in the installation program for the OpenWorks
database instance. Installation no longer requires separate Oracle media.

* The OpenWorks database installer supports configuring your database to run in either
ArchiveLLog mode or NoArchiveLog mode. Archivelog mode supports hot backups,
incremental backups, and point in time recovery. Nightly backups can be scheduled and users
can configure backup retention policies.

» Database Query Tool provides a graphical user interface to perform simple database queries
and to run pre-defined SQL scripts in order to troubleshoot data in a project.

* The new Database Administration tool provides a graphical user interface to run SQL scripts
for troubleshooting purposes. With this tool, the Oracle user (database administrator) can:

* Run Landmark-supplied SQL scripts in order to perform system level functions.

* Configure and execute incremental backups and archive logs using Oracle Recovery
Manager (RMAN).

* Repair a damaged database instance.
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e Recover a full database instance.
¢ (Clone a database instance.

* Upgrade an OpenWorks database instance from Oracle 10.2.0.x to Oracle 11.2.0.2.

NOTICE: Future Support for Operating Systems

Landmark regularly reviews our industry-leading software suite to verify that our product lines
meet marketplace demands for implementation on the most appropriate and widely accepted
technologies. Our goal is to focus our efforts where they will bring you the most value.

After careful consideration, and beginning with version 5000.10.x.x of the OpenWorks® software,
Landmark will no longer release the OpenWorks® software on the following operating systems:

¢ Microsoft Windows® XP 32-bit, 64-bit

e Microsoft Windows® 2003 Server 32-bit, 64-bit
* Red Hat Enterprise Linux® 4.x 32-bit, 64-bit

* Red Hat Enterprise Linux® 5.x 32-bit only

The last versions of the OpenWorks® software tested on the above operating systems will be with
the 5000.8.x.x product cycle. Landmark Customer Support will continue to provide support for the
versions of the OpenWorks® software on the above operating systems.

We based this decision on limited customer demand for the OpenWorks® software on these
operating systems as well as market trends indicating that most applications for the oil and gas
industry will standardize on fewer operating systems. The costs to support multiple operating
systems and platforms are large and reduce the velocity with which we can serve our customers by
producing new releases and delivering functionality.

Going forward, the OpenWorks® software is committed to Red Hat Enterprise Linux® and
Microsoft Windows® as the operating systems for our products. These operating systems not only
offer excellent functionality, but also deliver major gains in price-performance.

Please be advised that this statement is formal notification as set forth in the terms and conditions
of Landmark’s standard maintenance and support contract. We regret any inconvenience that this
decision might cause, and we are prepared to work with you to minimize any potential disruptions
within your operations.

Please contact your Account Executive with any concerns or if you desire any further information.
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System Requirements

Complete system requirements for each platform are contained in the OpenWorks® Software
Installation Procedures.

Installation Instructions

Refer to the OpenWorkse Software Installation Procedures for detailed installation information.
The document is available in the Landmark Software Manager (LSM) from the Install Info
button ( [% ) for the installation program.

The Installation Procedures manual has information about:

* Creating an installation of the OpenWorks® software and its database instance.

* Upgrading a previous version of the OpenWorks® software, possibly upgrading the Oracle
software (depending on whether a new version of the Oracle software is supported by the new
version of the OpenWorks software), and possibly upgrading (or extending) existing projects.

If the OpenWorks® Data Model has changed in the new version of the OpenWorks® software,
the projects in an existing database instance must be upgraded (or extended) before the projects
can be managed or used in the new version of the OpenWorks software, or before they can be
used by other applications that support the new version of the OpenWorks software. The
information about upgrading projects is in the “Upgrade the OpenWorks® Software” chapter
of the Installation Procedures manual.

Oracle Advanced Queuing and Post-installation Instructions in the Installation
Procedures Manual

The Oracle database for the OpenWorkse database instance uses Oracle Advanced
Queuing for communicating messages between applications. Overtime with Oracle 10g
or 11g databases, millions of expired Oracle Advanced Queuing (AQ) messages could
build up in the database and cause severe performance issues.

The Knowledge Base Solution S10092, “Oracle Advanced Queuing Issues in the
OpenWorks R5000 Database,” contains information which helps you recognize whether
the AQ messages are building up in the database, and it provides a method for removing
the messages.

Landmark strongly recommends that you follow the procedure in Solution S10092 after
the installation of the OpenWorks database instance to prevent database performance
issues.
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Third Party Applications
Halliburton uses various third party applications in the development of its software.
Halliburton acknowledges that certain third party code has been bundled with, or embedded in, its
software. The licensors of this third party code, and the terms and conditions of their respective
licenses, may be found at the following location:

SOWHOME /docs/third_party.pdf Linux

SOWHOME%\docs\third _party.pdf Windows
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International Trade Compliance

This application is manufactured or designed using U.S. origin technology and is therefore subject
to the export control laws of the United States. Any use or further disposition of such items is
subject to U.S. law. Exports from the United States and any re-export thereafter may require a
formal export license authorization from the government. If there are doubts about the
requirements of the applicable law, it is recommended that the buyer obtain qualified legal advice.
These items cannot be used in the design, production, use, or storage of chemical, biological, or
nuclear weapons, or missiles of any kind.

The ECCN’s provided in Release Notes represent Halliburton’s opinion of the correct
classification for the product today (based on the original software and/or original hardware).
Classifications are subject to change. If you have any questions or need assistance, please contact
us at:

FHOUEXP @halliburton.com

Under the U.S. Export Administration Regulations (EAR), the U.S. Government assigns your
organization or client, as exporter/importer of record, responsibility for determining the correct
authorization for the item at the time of export/import. Restrictions may apply to shipments based
on the products, the customer, or the country of destination, and an export license may be required
by the Department of Commerce prior to shipment. The U.S. Bureau of Industry and Security
provides a web site to assist you with determining the need for a license and with information
regarding where to obtain help. The URL is:

http://www.bis.doc.gov

Definitions

CCATS (Commodity Classification Automated Tracking System) — the tracking number
assigned by the U.S. Bureau of Industry and Security (BIS) to products formally reviewed and
classified by the government. The CCATS provides information concerning export/re-export
authorizations, available exceptions, and conditions.

ECCN (Export Control Classification Number) — The ECCN is an alpha-numeric code, e.g.,
3A001, that describes a particular item or type of item, and shows the controls placed on that item.
The CCL (Commerce Control List) is divided into ten broad categories, and each category is
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further subdivided into five product groups. The CCL is available on the EAR web site (http://

www.access.gpo.gov/bis/ear/ear_data.html#ccl).

The ECCN Number, License Type, and the CCATS Numbers for this product are included in the

table below.

Product/Component/ ECCN Number | License | CCATS Number
Version 5000
OpenWorks® Software 5D002C.1 ENC G054746
GeoDatalLoad™ Software | 5D002 ENC G049393

5000.8.3.0 Release Notes — Revised
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Enhancements and New Functionality

This section describes the changes in the OpenWorks® software.

OpenWorkse Software

OpenWorks® Launcher in Windows for OpenWorks® and Landmark applications.

No data model extensions. Any application that works with version 5000.8.1.0 of the
OpenWorks® software will work with version 5000.8.3.0.

Defect fixes.

Changes were made in the following components of the OpenWorks® software:

Change Color Scheme General Units Converter Project Administration
Change Oracle User Interpretation Data Project Status
Password Manager
Checkshot Data Manager Interpretation ID Manager | Project Upgrade
(Linux Only)
Curve Dictionary Launcher Script for Seismic Data Manager
OpenWorks® Java
Applications

Data Domain Manager

Lease List Manager

Seismic List Manager

Database Administration

Lithologic Symbol Editor

SeisWorks® Development

Tool — New Kit (for seismic data
access)

Database Query Tool Map Projection Editor Special Units Editor

DecisionSpace Mapping Overlay Manager | Surface/Fault Data

Infrastructure (Linux Only) Manager

Deviation Data Manager

Measurement System

Well Curve Viewer

(Linux Only) Manager
Error Logger Modify Database Users Well Data Manager
Extend2Dline Utility OpenWorks® Development | Well List Manager
Kit™
Field List Manager OWSW (OpenWorks® and | Well Symbol Editor
SeisWorks®) Data Access
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GeodatalLoad™ Software

e Data Import and Data Export Tools

* Data Import and Data Export Wizards are refashioned to make them easier to use, and
renamed Data Import and Data Export. The wizard actions have been removed.

* Added to the Basic installation of the OpenWorks® and GeoDatalLoad™ software.

* Improved tab interface, format editor, and other interface improvements.

* New import data types

Horizon Data: Replaces the Mltexp utility, except for the binary formats, from the
SeisWorks® software.

Log Curves: Replaces Curve Loader for DLIS, LAS, and LIS formats, but not user-
defined ASCII formats. For this release, Curve Loader is still included with the
GeoDatalLoad™ software.

Well Data: Imports well data and some data types which loaders in previous versions
might have loaded, such as position logs, directional surveys, time-depth tables, and
synthetics. Replaces ASCII Loader, but ASCII Loader will remain in the
GeoDatalLoad™ software in order to load non-well data, such as lease information,
and to load data in formats not yet supported in the Data Import tool.

Loader formats, such as IHS 297 and IHS 298 for ASCII Loader, and GeoGraphix®
Wellbase ASCII 3, are supported in the Data Import tool.

* SEG Y Loader is refashioned and supports more data types. It is now called SEG Y Data

Import.

* New supported data types:

SEG Y 2D stacked

SEG Y 3D stacked

Multiple SEG Y 2D stacked
SEG Y Prestack 3D data sets
Promax Prestack 3D data sets

JavaSeis Prestack 3D data sets
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e Batch stacked data sets

¢ New Format editor

* New SEG Y Data Export.

‘ Go To “What'’s in this Release?”

* Stimulation Data Loader supports multiple monitor wells.

e Defect fixes.

* Changes were made in the following components of the GeoDatal.oad™ software:

ASCII Loader (Well Raster Log Import
Import)

Curve Loader SEG Y Data Export
Data Export Wizard SEG Y Data Loader
Data Import Wizard Stimulation Data Loader

Project Data Transfer

Well Data Export

* Supported and tested formats for Data Import, and SEG Y Data Import:

Data Type Format Type Version
Log Curves DLIS
LAS 1.2,2.0
LIS
Wells GeoGraphix® Wellbase 3
ASCII
IHS 297 fixed-length fields, comma-delimited
fields
IHS 298 fixed-length fields, comma-delimited
fields
SEGY 2D stacked Revision 1
3D stacked SEG-P1, Revision 1
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Fixed Issues

This section lists the most important issues and enhancements in the OpenWorks® and the
GeoDatalLoad™ software.

OpenWorkse Software

Configuration, Installation, and Generally

Defect ID
* 895338
« 899107

Summary
Installation: Add the new java loaders to the Basic installer in Windows.

Installation: Add check for the StratWorks® executable links in SOWHOME /bin
to fmover and SegMenter.

Data Management

Defect ID
* 886147
* 894247
* 894960
* 902744

Summary

Seismic Data Manager: 2D line navigation is incorrect in ALL_DATA when
loaded to an interpretation project (10 shotpoints with similar X,y coordinates).

Seismic Data Manager: Loading 2D SEG Y data produces a blank window in the
2D survey list.

Seismic Data Manager: Pack&Go 3D horizon import fails if Update 3D Survey is
not selected.

Seismic Data Manager: Conversion of the coordinate reference system (CRS) for
2D navigation data between a UTM and Lambert projection types produces
incorrect results.
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Database

Defect ID  Summary

* 866665 Database: When installing a fresh embedded Oracle database, the Oracle links
should be included in the installation.

* 873972 Database: While interpreting 2D lines and with eight sections tabs open displaying
different lines, the DecisionSpace® Desktop™ software crashes.

* 900243 Database: Oracle 10g to 11g upgrade. Spurious warning or error message about
resource limits.

Project Management

Defect ID  Summary

* 893459 Project Administration: logginglPRefresh.properties security hole. When
modified for log output, it contained the name and password for the project
database.

GeoDataload™ Software

ASCII Loader

Defect ID  Summary

» 852703 ASCII Loader: On upgrade, Well Location Alternate and Well Surface Alternate
Location, drop requirement to have Well Location ID.

857127 ASCII Loader: Well Header data lists Well Location ID as a Required Foreign
Key.

* 860856 ASCII Loader: Allow easy or automatic loading of IHS production data.

881565 ASCII Loader: Second update messes up Well Location and Well Header
associations.

e 890192 ASCII Loader: IHS297 formats (OCS, NE, CONG) do not load Well Location
information.
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* 892695 ASCII Loader: Need the ability to load IHS298 comma delimited files.

* 894246 ASCII Loader: String replacement: By default Display All is selected when File >
Open loads file to memory.

Curve Loader

DefectID  Summary
e 873857 Curve Loader: Utilize the service names.

* 884630 Curve Loader: Update fields will update coordinate reference system (CRS) and
change x,y coordinates, when the CRS of the well is different from the CRS of the
project.

889787 Curve Loader: Public interpretation ID loading a directional survey on top of a
directional survey owned by a private interpretation ID generates orphan position
log vectors.

* 890314 Curve Loader: CrvldrBatch does not send out notification, Well Data Manager has
to be refreshed to see new or updated data.

e 898896 Curve Loader: Need a warning when adding new curve name to the Curve
Dictionary.

Data Export

Defect ID  Summary

884014 Data Export: Fails on large project.

884094 Data Export: Restoring a project updates the Fault_Plane table.
* 886028 Data Export: Unable to find export centerlines option.

886554 Data Export: Export shotpoint/trace ratio for 2D lines as per legacy Seismic Data
Loader.

* 898380 Data Export: Default Hungarian EOV fails to export grid and point set data.
Produces a java.lang.NullPointerException (Mapping Translator to Writer).
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Data Import

Defect ID  Summary

851813 Data Import: Review terminology used in Data Import and improve
documentation.

870131 Data Import: Point Set To Grid data type: Imports evenly spaced rotated x,y,z data
file without errors, but grid is inverted.

871312 Data Import: Cannot import or export horizons on Windows 7.

872765 Data Import: Crash and NullPointerException on import of fault data in Z-MAP™
format.

881389 Data Import: Format to match legacy file format of version 2003 of the fie (fault
import and export) application.

* 884269 Data Import: GeoShape data type: Issues with file saved as comma delimited.
884280 Data Import: GeoShape data type: Imports data with header info as part of data set.
* 886425 Data Import: ZMAP format VERT file (polygons) crashes Data Import.

* 886575 Data Import: Raster Log Import data type: SIF/TIF pair fail to import.

886594 Data Import: Custom format for ZMAP Mapping Polygon (VERT) file crashes
Data Import.

887202 Data Import: Loading 2D navigation data from two separate files.
888370 Data Import: Fault data type: Does not handle comma delimited data file correctly.

o 888772 Data Import: Fault segment failed to import if format file without x,y coordinates
defined.

889114 Data Import: Enable Data Import to load LAS files.

* 890995 Data Import: Log Curves data type: Load curves containing all NULL values,
which the old loader would not load, thus causing problems in Well Data Manager.

* 891257 Data Import: Microseismic job fails to load if firstEventTime is not
specified.

* 891349 Data Import: Unchecking Hide Comments and creating a format causes some data
to not load.
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Data Import: Cntr Min and Cntr Max values stored incorrectly with the setting of
the Positive SSTVD Values In The Input File Are options.

Data Import: Setting OW_GDL_WIZARD_MEMORY_LIMIT in Igcenv.cf is not
working.

Data Import: Importing text grid gives SEVERE error, but expecting a float error.

Data Import: Data on the either side of the international dateline gets flipped or
mirrored.

Data Import: Importing multiplexed point sets fails to record ZNon in all Point
Set Field rows.

Data Import: With auto-detect format option, not correctly importing fault
polygons in the Z-MAP Plus™ format.

Data Import: Wells data type: For IHS data files with fixed-length fields, the well
location UWI mapping in the format is not honored. The well location UWI can be
manually mapped on the Format tab. However, when the well location UWI is
mapped to a truncated well UWI from the data file, the truncated UWI for well
location UWI is not honored, and the full UWI is imported for the well location
UWL

GGX ASCII 4 Exporter

Defect ID

* 864219

Summary

GGX ASCII 4 Exporter: Well Header is exported multiple times when export log
curve.

Raster Log Import

Defect ID
« 872570
882001

Summary

Raster Log Import: Raster Log importer is truncating well UWI’s, when one of
the import wells has less than 12 characters.

Raster Log Import: Case sensitivity when loading depth registered raster logs in
SIF format.
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SEG Y Data Export

Defect ID

* 887005

Summary

SEG Y Data Export:

SEG Y Data Import

Defect ID
* 864411
* 865549
* 865551
* 865552
* 865553
* 865556
* 865557
* 871556
* 880423
* 880537
* 901021

Summary

SEG Y Data Import:
SEG Y Data Import:
SEG Y Data Import:

SEG Y Data Import:
format).

SEG Y Data Import:

SEG Y Data Import:
really annoying.

SEG Y Data Import:
SEG Y Data Import:
SEG Y Data Import:
SEG Y Data Import:

SEG Y Data Import:

ﬁ Go To “What'’s in this Release?”

SEG Y exported from Windows 7 only environment.

Default color map should be gray-scale, not spectrum.
Trace header table display minimum and maximum bytes.
Load details should be filled out.

Extend export to other formats than 32-bit BRI (brick

Set multiple values at a time.

Location of action buttons in bottom right of window is

Simplify SEG Y data loading workflow.

SEG Y export in SEG Y Data Import.

Ability to output to CMP format.

Better error handling when dir.dat has no seismic directory.

Selection of the 3D survey should be under the Navigation

tab rather than under the Import tab.

Stimulation Data Loader

Defect ID

* 890722

Summary

Stimulation Data Loader: User with Interpret role cannot create new wells if
Interpretation ID PINN pre-exists.

5000.8.3.0 Release Notes — Revised
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Well Data Export

Defect ID  Summary

898745  Well Data Export: GES_WBA2.wix and GES_WBA2.wdl do not include any
Original X/Lon or Y/Lat fields from Well Header, only Latitude/Longitude fields.
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Known Issues

This section lists the important issues that exist in the OpenWorks® and GeoDatalLoad™ software.

OpenWorkse Software

Configuration, Installation, and Generally

Defect ID  Summary

Oracle Advanced Queuing and Post-installation Instructions in the Installation
Procedures Manual

The Oracle database for the OpenWorkse database instance uses Oracle Advanced
Queuing for communicating messages between applications. Overtime with Oracle 10g
or 11g databases, millions of expired Oracle Advanced Queuing (AQ) messages could
build up in the database and cause severe performance issues.

The Knowledge Base Solution S10092, “Oracle Advanced Queuing Issues in the
OpenWorks R5000 Database,” contains information which helps you recognize whether
the AQ messages are building up in the database, and it provides a method for removing
the messages.

Landmark strongly recommends that you follow the procedure in Solution S10092 after
the installation of the OpenWorks database instance to prevent database performance
issues.

* 896165 Windows Launcher: Issue with the drag and drop arrangement of icons.

Project Administration

Defect ID  Summary

* 901646 Project Administration: Cannot create interpretation project using Windows
command line due to missing AOI coordinates.
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GeoDataload™ Software

Data Import

Defect ID  Summary

* 892804 Data Import: Contour Set data type: Definition of Remark as a prompted value is
ignored in format for data type.

* 895087 Data Import: Log Curves data type: Needs a command line batch mode loading
option.

895178 Data Import: Log Curves data type: On the Load Options tab, if curves already
exist for the well, need an option for Append.

* 895323  Data Import: Log Curve data type: On the Format tab, a user has the ability to save
over the delivered formats.

* 895446 Data Import: Log Curve data type: On the Format tab, a revert and refresh button
is needed for the mnemonics table.

* 895983 Data Import: Log Curve data type: When new mnemonic rows are added in the
Format tab, the rows only appear at the bottom of the table.

* 900992 Data Import: Job Date is not picked correctly from data file.

* 901560 DataImport: Log Curve data type: When selecting the data type, a delay of several
seconds before the Log Curve Data Type panel is displayed. No delay in display
time for the other data types.

* 901957 Data Import: Microseismic data type: Need a data scan to identify what date
format the file is in.

* 902167 Data Import: Job running tool bar doesn't match actions. Reaches 100% before the
process is completed.

* 902299 Data Import: Log Curve data type: For DLIS and LIS formats, the depth curve is
imported and displayed in OpenWorks. The depth curve is not imported for the LAS
format.

* 902379 DataImport: Wells data type: On the Format tab, the Add New File Section button
is active when there is no parent section selected.
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902742
* 902824
* 902916
* 903113
* 903267
* 903320
903727
903741
* 903742
* 903823
* 903834
* 903946
* 904450
* 904808
* 904818
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Data Import: Log Curve data type: On the Data Type tab, the Date Format settings
informs users that date containing / or a time stamp are not imported.

Data Import: Wells data type: When validating a format from the Format tab, no
way to tell the validation is running.

Data Import: Horizon data type: Should provide a pick list if 3D survey is defined
as a Prompt For item.

Data Import: Wells data type: Data Import crashes when load summary exported
to an invalid location.

Data Import: Needs to be able to import lat/lon values in decimal form for seismic
2D lines.

Data Import: Contours data type: When a contour file does not contain the
expected flag, the new flag can be mapped, but the import causes Data Import to
crash.

Data Import: Log Curve data type: Format File Editor displays a blank mnemonic
for some log files.

Data Import: Log Curve data type: In Format File Editor, if an input mnemonic not
found in a format file is added, but renamed, the input indicator is not correct.

Data Import: Log Curve data type: In Format File Editor, multiple mnemonics are
listed in mnemonics not found table when multiple data files are selected.

Data Import: When the Data Import tool is resized, the buttons at the bottom get
cut off.

Data Import: A new well location UWI is created for each well header, even if the
data file has the same Well Location UWI for all well headers.

Data Import: Horizon data type: Do not enable Import tab if a 3D Survey is not
available for mapping of horizon.

Data Import: Log Curve data type: In Format File Editor, in the
DefaultCurvelmport.bcl file, the Attribute Well Operator is not on the Attribute
select list, but it is displayed as the default attribute value for CN, COMP, and
COMPANY.

Data Import: Wells data type: Issue with the string replacement tool where the
active window gets stuck behind the Data Import window and cannot be selected.

Data Import: The IHS298prep.nawk script causes issues when loading data from
IHS 298 data files with Data Import, where the file contains fixed-length fields.
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If an IHS 298 data file had been copied from or to the Windows environment prior
to executing the Nawk script, the script might have left unnecessary Return
characters in the data file. The unnecessary Return characters may cause Data
Import to load the data incorrectly.

Workaround: Data Import does not require changes to the data which the Nawk
script makes.

If possible, use the original version of the file, and not the one changed by the Nawk
script.

However, if the Nawk script has already been run on a data file, the following
command replaces the unnecessary Return characters with Space characters,
allowing you to load the data with Data Import and its IHS 298 format file, included
in version 5000.8.3.0. The following command will replace the Return characters
in a data file with Space characters:

cat -v SourceDataFile.98f | tr "~M" " " > ProcessedDataFile.98¢f

For example, if the source file is THS_TestData_WinNawkIssue.98f and
the processed file is THS_TestData_Nawk.98f, the command would be the
following:

cat -v IHS_TestData_WinNawkIssue.98f | tr "~M" " " > IHS_TestData_Nawk.98f

* 906055 Data Import: Log Curve data type: Petrophysical values cannot be added in log
curve format editor.

* 906083 Data Import: Wells data type: If the well location already exists in the project
database, import into the interpretation project fails.

* 906178 Data Import: Log Curve data type: Petrophysical parameter values in delivered
formats should exist in the default Petrophysical Parameters table.

* 907074 Data Import: Wells data type: Original BH (Bottom Hole) x,y data is not being
calculated on import for directional survey data.

* 907906 Data Import: Wells data type: Well location UWI does not map to a location

correctly in IHS297 data files with fixed-length fields for a specific format mapping
configuration. For example, if the well location UWI is mapped to part of the API
number, while the well UWI is mapped to the UWI value in the data file, the well
location UWI does not import correctly. On import, the mapped partial API value
is ignored and the full UWI value is used for the well location UWI.
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Workaround: Map the UWI data item of the Well Header category and the partial
Well Location UWI data item to the same location in the START US_WELL file
section of the data file.

Data Import: Log Curve data type: Issues when importing LAS data files with the
version number 2 .00; however, Data Import can load LAS data files without
issues when the version number is 2. 0.

Workaround: To change the version number in a number of LAS data files in a
directory, a shell script can edit all files in the directory. The commands below will
change the version number from 2.00 to 2. 0, overwriting the existing LAS data
files in the directory.

To use the shell script:

* Open a terminal window in Linux, or open an MKS shell in a Command
Prompt window in Windows.

* Change directories to the directory where the files are located.

* Run the following command within the directory where the LAS data files are
located.

In Linux (recursive; searches for files in the current directory and in any

subdirectories):
find . -type f -name "*.[L,1][A,a][S,s]" -print0 | xargs -0 sed
-1 's/2.00\([: \t]\+Ver[: \t]\+\)2.00/2.0\12.0/"

In Linux (non-recursive; searches for files only in the current directory, and not
in subdirectories):

find “pwd® -maxdepth 1 -type £ -name "*.[L,1][A,al[S,s]" -
print0 | xargs -0 sed -1 's/2.00\([: \t]\+Ver[: \t]\+\)2.00/
2.0\12.0/"

In Windows (non-recursive; searches for files only in the current directory, and
not in subdirectories):

for i in $(find ‘pwd' -level 0 -name "*.LAS"); do ( echo
Processing $i; mv $i $i.orig ;sed 's/2.00\([: \t]\+Ver[:
\tI\+\)2.00/2.0\12.0/"' $Si.orig > $i) ;done;
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The shell solution is available in script form from Knowledge Base
Solution S12784 on the Landmark Customer Support Portal.

Alternatively, manually edit each LAS data file by replacing 2.00 with 2.0, or
load the LAS data files with the 2.00 version number with Curve Loader.

* 907988 Data Import: Log Curves data type: In the Windows operating system, an import
fails for LAS data files from the Petrel software, where a data file contains a date
with a time stamp in it.

Workaround: Do one of the following: Edit the LAS data file, and remove the time
stamp. Or, edit (or create a new format file from) the format file,
DeafaultCurvelmport.bcl, and remove the Date mnemonic.

* 908298 Data Import: Log Curves data type: In Windows, scan crashes when more than 159
LAS data files are selected for import.

Workaround: Load less than 150 data files at a time.

SEG Y Data Export

Defect ID  Summary

* 902473 SEG Y Data Export: Shotpoints that are not whole numbers are exported as
duplicates in SEG Y Export.

* 903045 SEG Y Data Export: Exporting seismic data sets and using them to extract
navigation results in loss of precision of x,y values.

SEG Y Data Import

Defect ID  Summary
* 894940 SEG Y Data Import: Need table sort function in batch import.
* 894941 SEG Y Data Import: Add SEG Y Analyzer function in 2D import.

897584 SEG Y Data Import: Add a option to calculate the expected memory
requirements.

* 899088 SEG Y Data Import: Add the capability to merge to an existing data set.
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SEG Y Data Import: Prestack import of JavaSeis: The Import tab, Assigned
Gather header does not match the Tertiary Header Name after scanning.

SEG Y Data Import: Page forward button gives no indication that the user is at the
end of the trace range.

SEG Y Data Import: Should respond to session change instead of forcing an exit.

SEG Y Data Import: Add some echo statements to the console output of the
SEG Y batch command showing progress.

SEG Y Data Import: Does not support extracting navigation from a geographic
coordinate reference system (CRS).

SEG Y Data Import: Provide information about parameters used in SEG Y Data
Import.

SEG Y Data Import: Add to the data model the ability to support stack SEG Y data
access just like prestack SEG Y data access is supported.

SEG Y Data Import: Provide usage for SegYBatchl.oader command when no
arguments are given.

SEG Y Data Import: Provide informational output to the SEG Y Data Import
window.

SEG Y Data Import: Should get warning if no 2D line navigation is successful.
SEG Y Data Import: Error logging for SEG Y Import is not behaving correctly.

SEG Y Data Import: Generating 2D line name from .sgy ASCII header works
only if more than one row is selected.
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Compatibility with Discovery™ On OpenWorks®
Software

The Discovery™ on OpenWorks® (DOW) software directly links a Discovery™ application to the
data in an OpenWorks® project, and provides a shared project environment for interpretation
applications. Landmark has delivered the OpenWorks and DOW software for Release 5000, and it
will continue to provide updates and enhancements to these products. When planning your uptake
of Release 5000 and verifying your workflow, you should consider version compatibility between
the OpenWorks software and the Discovery on OpenWorks software.

In the Compatibility Table section below, the table indicates the level of compatibility of previous
releases and of upcoming scheduled and planned releases. This table will be updated as new
releases are planned. The objective is to provide closely coupled compatible versions of the
software to allow you to more easily take up current releases.

Landmark performs full release testing for those combinations indicated as Release in the table,
but may not exercise full release testing on other version combinations. For these interactive
releases, Landmark performs compatibility testing between the OpenWorks and DOW software
(indicated as Compatibility in the table). See the table below for the level of testing for each version
combination. Although Landmark does not anticipate any integration issue, it is recommended that
customers also verify compatibility in their own environment.

Landmark supports the versions listed as Release in the table. However, while Landmark has
completed compatibility testing, Landmark Support may not be able to fully support the versions
listed as Compatibility in the table. When requesting support for a Compatibility environment,
Landmark Support works on a best effort basis to troubleshoot any issues, and if an issue needs
additional attention, Landmark Support reports such issues to the Research & Development group
of Landmark. Landmark Support cannot guarantee any resolution service levels associated with
issues from a Compatibility environment.

Combinations which have not been tested, either in the full release or in a compatibility
environment, are listed as Untested. Combinations of versions not listed are Not Compatible and
will not operate together, or the version was not released at the time this document was published.

The most current version of this information, and an overview of suggested compatibility test
paths, is available as Solution Documents 170465, 176387, 183685, and 185767.
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Compatibility Table

Bold in the Release Version columns indicates a major version change in the software.

DOW OpenWorks Verification Testing
Release Version | Release Version
License Version

July, 2011 2012.0.0 5000.8.0.0 Release
5000.02

March, 2011 2012.0.0 5000.0.3.5 Compatibility
5000.02

December, 2010 | 2012.0.0 5000.0.3.0 Compatibility
5000.02

November, 2010 | 2012.0.0 5000.0.2.9 Untested
5000.02

November, 2010 | 2012.0.0 5000.0.2.8 Untested
5000.02

August, 2010 2012.0.0 5000.0.2.7 Untested
5000.02

March, 2011 5000.0.2.5 5000.0.3.5 Release
5000.02

December, 2010 | 5000.0.2.5 5000.0.3.0 Compatibility
5000.02

November, 2010 | 5000.0.2.5 5000.0.2.9 Untested
5000.02

November, 2010 | 5000.0.2.5 5000.0.2.8 Untested
5000.02

August, 2010 5000.0.2.5 5000.0.2.7 Release
5000.02

December, 2010 | 5000.0.2.1 5000.0.3.0 Release
5000.02

November, 2010 | 5000.0.2.1 5000.0.2.9 Untested
5000.02

November, 2010 | 5000.0.2.1 5000.0.2.8 Untested
5000.02

August, 2010 5000.0.2.1 5000.0.2.7 Release
5000.02
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DOW OpenWorks Verification Testing
Release Version | Release Version
License Version

November, 2010 | 5000.0.2.0 5000.0.2.9 Untested
5000.01

November, 2010 | 5000.0.2.0 5000.0.2.8 Untested
5000.01

August, 2010 5000.0.2.0 5000.0.2.7 Release
5000.01

March, 2010 5000.0.1.1 5000.0.2.2 Release
5000.01

September, 2008 | 5000.0.1.1 5000.0.0.3 Release
5000.01

November, 2009 | 5000.0.1.0 5000.0.2.0 Compatibility
5000.01

November, 2009 | 5000.0.1.0 5000.0.1.7 Release
5000.01

September, 2009 | 5000.0.1.0 5000.0.1.6 Compatibility
5000.01

August, 2009 5000.0.1.0 5000.0.1.5 Compeatibility
5000.01
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Contacting Landmark Customer Support

Landmark software operates Technical Assistance Centers (TACs) in Australia, the United
Kingdom, and the United States. Additional support is also provided through regional support
offices around the world.

¢ Support Via Web Portal
¢ Technical Assistance Centers

* Regional Offices

Support Via Web Portal

Support information is always available on the Landmark Customer Support internet page. You
can also submit a support request directly to Landmark Customer Support though the Landmark
Customer Support Portal:

http://css.lgc.com/InfoCenter/index?page=home
To request support in the Landmark Customer Support Portal:

1. In the PIN and Password text boxes in the Please Sign In area, enter your registered personal
identification number and password.

2. Click the Sign In button.

3. In the Case & Defect Information area, click the Create A New Case link.

4. Inthe Create Case area, fill in the necessary information. Provide details about your technical
concern, including any error messages, the workflow steps where the problem occurred, and
attachments of screen shots that display the problem. To help understand the concern, you can

also attach other files too, such as example data files.

5. Click the Submit button. A support analyst in the nearest Technical Assistance Center will
respond to your request.
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Technical Assistance Centers

Asia, Pacific
8:00 am - 5:00 pm Local Time
Monday-Friday, excluding holidays

Europe, Africa, Middle East
8:00 am - 5:30 pm Local Time
Monday - Friday, excluding holidays

Latin America
(Spanish, Portuguese, English)
7:00 am - 5:00 pm Local Time

North America
7:30 am - 5:30 pm Central Standard Time
Monday - Friday, excluding holidays

Regional Offices

t Go To “What'’s in this Release?”

61-8-9481-4488 (Perth, Australia)
Toll Free 1-800-448-488
Fax: 61-8-9481-1580

Email: apsupport@Igc.com

44-1372-868686 (Leatherhead, UK)
Fax: 44-1224-723260 (Aberdeen, UK)
Fax: 44-1372-868601 (Leatherhead, UK)

Email: support@Ilgc.com

713-839-3405 (Houston, TX, USA)
Fax: 713-839-3646

Email: soporte@lgc.com

713-839-2200 (Houston, TX, USA)
Toll Free 1-877-435-7542
(1-877-HELP-LGC)

Fax: 713-839-2168

Email: support@Ilgc.com

For contact information for regional offices, see the Contact Support page located at:

http://css.lgc.com/InfoCenter/index ?page=contact&section=contact

If problems cannot be resolved at the regional level, an escalation team is called to resolve your

incidents quickly.
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Suite, DMS, Drillability Suite, Drilling Desktop, DrillModel, DrilINET, Drill-to-the-Earth-Model, Drillworks, Drillworks ConnectML, Drillworks Predict,
DSS, Dynamic Frameworks to Fill, Dynamic Reservoir Management, Dynamic Surveillance System, EDM, EDM AutoSync, EDT, eLandmark, Engineer’s
Data Model, Engineer’s Desktop, Engineer’s Link, ENGINEERING NOTES, eNotes, ESP, Event Similarity Prediction, ezFault, ezModel, ezSurface,
ezTracker, ezTracker2D, ezValidator, FastTrack, Field Scenario Planner, FieldPlan, For Production, FrameBuilder, Frameworks to Fill, FZAP!, GeoAtlas,
GeoDatalLoad, GeoGraphix, GeoGraphix Exploration System, Geologic Interpretation Component, Geometric Kernel, GeoProbe, GeoProbe GF DataServer,
GeoSmith, GES, GES97, GesFull, GESXplorer, GMAplus, GMI Imager, Grid3D, GRIDGENR, H. Clean, Handheld Field Operator, HHFO, High Science
Simplified, Horizon Generation, 12 Enterprise, iDIMS, iEnergy, Infrastructure, iNotes, Iso Core, IsoMap, iWellFile, KnowledgeSource, Landmark (as a
service), Landmark (as software), Landmark Decision Center, LandNetX, Landscape, Large Model, Lattix, LeaseMap, Limits, LithoTect, LogEdit, LogM,
LogPrep, MagicDesk, Make Great Decisions, MathPack, MDS Connect, MicroTopology, MIMIC, MIMIC+, Model Builder, NETool, Nexus (as a service),
Nexus (as software), Nexus View, Object MP, OneCall, OpenBooks, OpenJournal, OpenLink, OpenSGM, OpenVision, OpenWells, OpenWire, OpenWire
Client, OpenWire Server, OpenWorks, OpenWorks Development Kit, OpenWorks Production, OpenWorks Well File, Operations Management Suite, PAL,
Parallel-VIP, Parametric Modeling, Permedia, Petris WINDS Enterprise, PetrisWINDS, PetroBank, PetroBank Explorer, PetroBank Master Data Store,
PetroWorks, PetroWorks Asset, PetroWorks Pro, PetroWorks ULTRA, PLOT EXPRESS, PlotView, Point Gridding Plus, Pointing Dispatcher, PostStack,
PostStack ESP, PostStack Family, Power Interpretation, PowerCalculator, PowerExplorer, PowerExplorer Connect, PowerGrid, PowerHub, PowerModel,
PowerView, PrecisionTarget, Presgraf, PressWorks, PRIZM, Production, Production Asset Manager, PROFILE, Project Administrator, ProMAGIC Connect,
ProMAGIC Server, ProMAX, ProMAX 2D, ProMax 3D, ProMAX 3DPSDM, ProMAX 4D, ProMAX Family, ProMAX MVA, ProMAX VSP, pSTAx, Query
Builder, Quick, Quick+, QUICKDIF, Quickwell, Quickwell+, Quiklog, QUIKRAY, QUIKSHOT, QUIKVSP, RAVE, RAYMAP, RAYMAP+, Real Freedom,
Real Time Asset Management Center, Real Time Decision Center, Real Time Operations Center, Real Time Production Surveillance, Real Time Surveillance,
Real-time View, Recall, Reference Data Manager, Reservoir, Reservoir Framework Builder, RESev, ResMap, Resolve, RTOC, SCAN, SeisCube, SEISINFO,
SeisMap, SeisMapX, Seismic Data Check, SeisModel, SeisSpace, SeisVision, SeisWell, SeisWorks, SeisWorks 2D, SeisWorks 3D, SeisWorks
PowerCalculator, SeisWorks PowerJournal, SeisWorks PowerSection, SeisWorks PowerView, SeisXchange, Semblance Computation and Analysis, Sierra
Family, SigmaView, SimConnect, SimConvert, SimDataStudio, SimResults, SimResults+, SimResults+3D, SIVA+, SLAM, Smart Change, Smart Deploy,
Smart Flow, Smart Skills, Smart Start, Smart Vision, SmartFlow, smartSECTION, smartSTRAT, Spatializer, SpecDecomp, StrataMap, StrataModel,
StratAmp, StrataSim, StratWorks, StratWorks 3D, StreamCalc, StressCheck, STRUCT, Structure Cube, Surf & Connect, SurfNet, SynTool, System Start for
Servers, SystemStart, SystemStart for Clients, SystemStart for Servers, SystemStart for Storage, Tanks & Tubes, TDQ, Team Workspace, TERAS, T-Grid,
The Engineer’s DeskTop, Total Drilling Performance, TOW/cs, TOW/cs Revenue Interface, TracPlanner, TracPlanner Xpress, Trend Form Gridding, Trimmed
Grid, Tubular Basic, Turbo Synthetics, Unconventional Essentials, VESPA, VESPA+, VIP, VIP-COMP, VIP-CORE, VIPDataStudio, VIP-DUAL, VIP-
ENCORE, VIP-EXECUTIVE, VIP-Local Grid Refinement, VIP-THERM, vSpace, vSpace Blueprint, vSpace Onsite, WavX, Web Editor, Well H. Clean, Well
Seismic Fusion, Wellbase, Wellbore Planner, Wellbore Planner Connect, WELLCAT, WellDirect, WELLPLAN, WellSolver, WellXchange, WOW, Xsection,
You’re in Control. Experience the difference., ZAP!, ZEH, ZEH Plot, ZetaAnalytics, Z-MAP, Z-MAP Plus, and ZPS are trademarks, registered trademarks,
or service marks of Halliburton.

All other trademarks, service marks, and product or service names are the trademarks or names of their respective owners.

Note
The information contained in this document is subject to change without notice and should not be construed as a commitment by Halliburton.
Halliburton assumes no responsibility for any error that may appear in this manual. Some states or jurisdictions do not allow disclaimer of expressed
or implied warranties in certain transactions; therefore, this statement may not apply to you.
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Third Party Licenses and Attributions

Halliburton acknowledges that certain third party code has been bundled with, or embedded in, it’s software. The licensors of this
third party code, and the terms and conditions of their respective licenses, may be found at the following location:

SOWHOME /docs/third_party.pdf Linux

SOWHOME%\docs\third party.pdf Windows

Disclaimer

The programs and documentation may provide links to external web sites and access to content, products, and services from third
parties. Halliburton is not responsible for the availability of, or any content provided on, third party web sites. You bear all risks
associated with the use of such content. If you choose to purchase any products or services from a third party, the relationship is
directly between you and the third party. Halliburton is not responsible for: (a) the quality of third party products or services; or (b)
fulfilling any of the terms of the agreement with the third party, including delivery of products or services and warranty obligations
related to purchased products or services. Halliburton is not responsible for any loss or damage of any sort that you may incur from
dealing with any third party.
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